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Introduction

TuxDiner is a modern point of sale application tailored to restau-
rants, that is supported on Linux(tm) and Windows(tm). With
TuxDiner you get a choice of using a touch screen interface or the
traditional keyboard interface, and indeed it is possible to use both !
Mixing of Windows and Linux or a Linux only or Windows only
environment is also supported.
A comprehensive selection of reports will assist you with the man-
agement of your business.

Support

Via Email at info@tuxsoft.co.za Be sure to include your support de-
tails in your email. In some areas you may have telephonic support.

Bugs

You can send all bug reports to info@tuxsoft.co.za via email or use
our bug reporting web portal. Users with a valid support option will
get a reply and a projected fix time rapidly, and yes we call problems
bugs, we fix bugs !
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1 Installing TuxDiner

1.1 Typical Computer Requirements

Operating System Linux 2.6 (Ubuntu 12.04LTS) / Windows Xp/7
Processor AMD Ryzen / Intel i3 - Or better
Memory 1 GB Min, 4GB or more recomended
Display 1024x768 Minimum / 1280x1024 recomended
Network 100Mbit or better

In addition the usual peripherals such as mouse, DVD, etc. are re-
quired. The above specifications may be replaced with higher per-
formance hardware at your leisure.

1.2 Windows Installation

Simply insert the TuxDiner CD into your CD-Drive. The TuxDiner
installer should start automatically, if not your windows installa-
tion is not standard and you should have the skills to start the in-
stall. If not contact your system administrator. Note that through-
out this manual the TuxDiner directory refers to the C:\Program
Files\TuxSoft folder. In addition wherever you see the path /opt/tuxsoft/
you should replace this with C:\Program Files\TuxSoft or C:\Program
Files (x86) if you are running 64Bit windows.
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1 Installing TuxDiner

1.3 Linux Installation

Most modern Linux distributions support some form of automount,
and as such the installer should just start. You will need to know
the root password, if not your system admin will need to do the
install. We recommend that you use the KDE environment. Note
that throughout this manual the TuxDiner directory refers to the
/opt/tuxsoft directory . In addition wherever you see the path folder
C:\Program Files\TuxSoft you should replace this with /opt/tuxsoft
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Creating a Database

In most cases before you create a database it is necessary to install
a SQL database server, you may choose to use the SQLITE option,
if you will run a single Linux or WindowsPC. With Linux it will
be possible to use multiple stations if using thin clients. Supported
database servers are MySql, Postgresql, and most ODBC interfaces.
You can obtain a copy of MySQL for Windows from http://www.mysql.com/
or from the contrib folder on the CD. We recommend you use
MySQL or MariaDB.
After installation you should find a dbTuxDiner entry in your sys-
tem’s start or K menu. The dbTuxDiner utility is used to configure
and populate a database for TuxDiner.
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1 Installing TuxDiner

Figure 1.1: Database Setup Page 1

The first page in the dbTuxDiner wizard will inform you of any
special requirements or useful information relating to your server
type.
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1.3 Linux Installation

Figure 1.2: Database Setup Page 2

On page two you can select your server type, host, Database user
name, Database user password, and database name. Not all database
servers support password protection, this is especially true on win-
dows platforms. When using SQlite the database name is a physical
path to the database file. Make sure you have permissions to read
and write to the location you choose.
When installing under Windows 98 you must use your computers
name. With windows XP you must use localhost or the physical IP
of your PC.
Linux makes use of any valid name or IP address.
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1 Installing TuxDiner

Figure 1.3: Database Setup Page 3

In most cases you will need to supply a name and password for
your database administrator. This is usually NOT the system root
password.
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1.3 Linux Installation

Figure 1.4: Database Setup Page 4

You may use the dbTuxDiner utility to restore a backup of your
database, or you can populate it with sample data from the backup
samples provided. When you first install TuxDiner it might be a
good idea to populate it with sample data so that you may learn and
play with the system before committing to a running live system.
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1 Installing TuxDiner

Figure 1.5: Database Setup Page5

An indicator showing the progress of the create and populate phase
is shown, the actual time depends on the type of server and size of
your database.
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1.4 Starting TuxDiner

Figure 1.6: Database Setup Page 6

You are now ready to run TuxDiner, you need to take note of the
Admin password if this is an empty or sample data install.

1.4 Starting TuxDiner

You can start TuxDiner from the TuxDiner menu in the KDE or Win-
dows start menu. In most cases there will also be an icon on your
desktop that will start TuxDiner. When running TuxDiner for the
first time you will need to log in as the Admin using the login code
of tux this can be changed using the Edit -> Preferences menu.
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2 Preferences

2 Preferences

2.1 SysInfo

Figure 2.1: SysInfo Page

The System Information page is used to configure your business
details, tax settings, and footers for various customer documents.
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2.2 Personnel

Facility is provided for two tax levies in either Inclusive or Exclu-
sive modes, if your country has more than two tax levies consider
emigrating to a more democratic place. Jokes aside if a tax levy
does not exist simply leave its name blank and its value at 0.0000
and TuxDiner will ignore it.

Your License or Lease is linked to the Store Name. This must be the
trading name of your business, if this changes you will need a new
License or Lease key.

As can be seen for the sample data it is possible to use trivial HTML
markups in the footer fields to achieve a more dramatic effect.

Language - the GUI and documents may use a specific language
catalogue. See the section on customisation for more information
on creating a new language.

2.2 Personnel

The Personnel page is used to add and manage personnel and their
privileges within TuxDiner.
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2 Preferences

Figure 2.2: Personnel Page

When you first run TuxDiner there will only be the Admin personnel
entry. Admin can not be deleted, however you should change the
Admin password. To do this simply type in the new password into
the Code field then click on the yellow Update button.

The next task will most likely involve adding a new personnel entry.
To do this click on the green New button. You will be presented
with a sequence of prompt dialogues as follows.
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2.2 Personnel

Figure 2.3: New User Name

The name you enter for the new user is the name that will be shown
in the Personnel users list and in the action log.

Figure 2.4: New User Initials

The initials are used in the Sales page to identify the sales person
and calculate any commission on sales.
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2 Preferences

Figure 2.5: New User Code

Lastly you will enter the users code. This is the code the user will
use to login to TuxDiner, all preferences and settings are linked to
the users code.
After adding a new user to personnel you can fine tune the various
preferences allocated to that user. These are described in more detail
here.

1. Commission - this value specified in percent is used to accu-
mulate commission on sales and applied to the pre-tax amount.

2. Cash Account - In some cases it may be desirable to have a
given user associated with their own cash sales account. This
would be needed if your installation has more than one POS
terminal.

3. GUI Style - This is just a modern day graphical gimmick, eye
candy to waste CPU !

4. Touch Interface - When checked the terminal will run in
touch screen mode. No menus will be shown and waiter, table
and document details are entered via popup dialogues.

5. Mail Statements - Checking this option will enable the user

24



2.2 Personnel

to print or email statements to all customers with a debit bal-
ance.

6. Email Runs - This option should be disabled as it is not yet
implemented.

7. Backup Database - Checking this option will enable the user
to create backups of the TuxDiner database.

8. Cash Up - Checking this option will enable the user to per-
form the daily cash up and / or view the current cash situation.

9. Month End - Checking this option will enable the user to
print out a month end report.

10. Receive Stock - Checking this option will enable the user to
accept stock and enter it into the system.

11. Adjust Rec. Stock Prices - Checking this option will allow
the user to change the pricing of items during the receive stock
operation.

12. Purge Clients - Checking this option will enable the user to
purge a customers account. All records will be removed from
the system, you will have an option to produce a printout for
back reference.

13. Merge Clients - Checking this option will enable the user to
merge two customer accounts into one. Useful when couples
get married, or when names differ slightly and two or more
accounts have been created for the same customer. For exam-
ple Byte and Pieces, and Bytes and Pieces CC.

14. Manage Merchandise - Checking this option will enable the
user to add and edit Merchandise that you stock.

15. Manage Services - Checking this option will enable the user
to add and edit Services that you perform.

16. Manage Suppliers - Checking this option will enable the user
to add and edit suppliers known to your company.

25



2 Preferences

17. Order Stock - Checking this option will enable the user to
activate the stock level and ordering process.

18. View Reports - Checking this option will enable the user to
view any of the available system reports.

19. View Audit Trails - Checking this option will enable the user
to view and print a complete audit trail of a given account, any
notes will be shown in this trail.

20. View Journal Trails - Checking this option will enable the
user to view and print a journal trail for a given account.

21. View Statements - Checking this option will enable the user
to view and print a customers statement.

22. Discount Sales - Checking this option will enable the user to
discount invoiced items.

23. Modify Preferences - Checking this option will enable the
user to do anything.

24. Tax Control - Checking this option will enable the user to
enable or disable tax levies on a item to be invoiced.

25. Price Override - Checking this option will enable the user
to override the price of an item that was retrieved from the
database.

26. Allow Unvalidated Items - Checking this option will enable
the user to invoice items not in the database, to be effective
the user also needs price override and tax controls.

27. View Action Reports - Checking this option will enable the
user to view and clear the action log. The action log contains
a history of any operation the user performs that is not normal
operational procedure.

28. Select only Table/Room - Checking this option will force the
system to have the waiter choose the table or room from a
graphical selection and disable typing the name.

26



2.3 Printers & Email

29. Sticky Cash Acc - Checking this option will make the default
account the cash account associated with the user, however
the user will still be able to select a client if needed.

30. Refunds - Checking this option will enable the user to accept
returned goods for refund.

31. Access Documents - when enabled the user will be able to
view an manipulate past documents using the Documents page.

32. Void Invoices - When enabled a user will have the option to
void an invoice if required.

33. Void Receipt - when enabled the user will have the option to
void a receipt is required.

When changing the active user settings the changes will become
effective after a second or two. Language and style changes should
be immediate.

2.3 Printers & Email

TuxDiner currently uses three printers. Physically these may all be
the same printer or multiple printers at various locations.

27



2 Preferences

Figure 2.6: Printer and Email Settings

The Invoice, Receipt and Kitchen printers are self explanatory and
used to print Receipts and Invoices. When enabled the Kitchen
printer can be used to create order slips for your kitchen is appli-
cable. The mailing printer is used to print all other customer doc-
umentation. Typically these documents would be posted to your
customers.

You may also choose to use a logo in your documents, you should
only choose logo’s that are of a reasonable size. The actual printer
configuration is system dependent, but should be familiar to most
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2.4 Misc

people. Logo support for slip printers is limited to printing images
that have been saved into the printer non volatile RAM. You need to
save the image to your slip printer using your printer manufacturers
utility.

In order to email documents to customers you need to be able to
connect to a SMPT server, the Email settings allow you to choose
the server and port number to connect with. TuxDiner can not keep
mail spooled waiting for an SMTP server. To use email the server
must be on-line.

2.4 Misc

The Miscellaneous page contains settings for the backup media writer
and the selections of fast cash banknotes. Bank notes can be used to
speed up and reduce errors in the receipt process.

29



2 Preferences

Figure 2.7: Misc

When the Qty Check option is checked, the quantity field in the
sales keyboard page will automatically get focus and highlight after
an item is scanned or located in the Item combo box. This is useful
in businesses where the quantity of items is often not 1.
When the Take Out Change option is checked, a dialogue prompt-
ing you for change provided is presented when the invoice is pro-
cessed. This allows a note to be added to the Invoice that is useful
for take out orders where change is sent with the delivery.
The Backup Media App. can be any command that will take a
file and write it to a backup medium. The %1 is replaced with the
backup file name you specify at backup time.
Bank Notes can be changed simply by clicking on the note or empty
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2.5 License

button, the Value field contains the value associated with the note.

Rounding allows you to round down your invoices to the nearest
cent in rounding value. For example to round to 10c intervals use
10, to round to the nearest Rand use 100

Interest on Arrears select the interest rate in % for account in ar-
rears.

Max statement days will determine the number of days an account
goes overdue before statements are no longer automatically mailed.

Epson DM-D Display Pole these settings determine how a display
pole, if any, is attached to the system.

Cash Drawer these settings determine how a simple serial cash
drawer, if any, is attached to the system. If you use your slip printer
kick facility you need to fill in those details on the printer page in
the slip settings for Cash Draw.

2.5 License

The license page provides fields where you can enter your number
of tills and license key information. Once a valid key is entered the
3 Table limit and watermark on printouts will be removed.
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2 Preferences

Figure 2.8: TuxDiner License
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3 Basic Operation

Figure 3.1: Basic Keyboard Interface

In this chapter we describe the basic operation of TuxDiner from
the moment a customer walks in your door till they leave after pay-
ing. For a waiters terminal you may wish to enable the Select only
Table/Room preference. This will help prevent errors with client
selections and simplify the user interface.
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3 Basic Operation

Figure 3.2: Touch Screen Interface

3.1 Sales by touch interface

The most common operation of sales is likely to be that using the
touch screen interface. This would be the default method for wait-
ers. A waiter is a user who has the touch screen interface option
enabled in preferences.
The touch interface is fast and simple to use, it is arranged by depart-
ment with the toplevel being the department selection ordered by
rank, which is set in Department management. Within each depart-
ment the item icons are arranged as per their rank order in inventory
management.
By default one item is added to the invoice when its icon is clicked,
compositions will add multiple items based on the composition con-
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3.1 Sales by touch interface

tents. To change the number of items to add activate the Qty button
then select the desired auantity using the number pad.

Figure 3.3: Quantity editing on the Touch Interface
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3 Basic Operation

3.2 Sales by keyboad

In the Name field you can fill in the table number, customers name
or part thereof . Focus can be changed to the name field using F1,
Thats pressing the F1 key.
After entering the name or part thereof press Enter if a match is
found it will be displayed in the combination box. If more than
one match occurred, pressing F4 will drop down a list of available
matches. If using our sample data try D you should get a match of
D. DUCK’O
Once you select the client the system will focus on the Waiter field
you need to enter a valid waiter code and press enter, after this you
can add items to the bill.
Now you are ready to invoice, select the item field in sales by press-
ing F2 and then enter GREEK as we would like to add a GREEK
SALAD to the invoice. Either press Ctrl+A or click the Add but-
ton, you can also just press Enter, the Quantity field will then have
focus, you can change the quantity if required, pressing enter again
will add the item.
This behaviour can be changed in preferences in the Misc section by
checking or unchecking the Qty Check button. When unchecked,
enter will add a single item immediately as was the case in Version
2.0 and before.
Next we would like to add a Californian pizza to our Invoice, this
time however we will use the product code, enter 35 and press En-
ter.
We are now ready to place the order, this is done by touching or
clicking the pink Order button, pressing F7 is the shortcut for key-
board use. When the order is placed the associated items are printed
onto the kitchen printers and the interface returns to the waiter login
state.
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3.2 Sales by keyboad

Should we have enabled the Take Out Change option the follow-
ing dialogue will be presented where we may enter an amount for
change to be provided for. Leving the amount as 0 or by selecting
cancel will not add a change note to the invoice.

Figure 3.4: Change For Dialogue

When the client is ready fore their bill, the table is seleceted and the
green Print Bill button activated or F8 is pressed. The bill will be
printed onto the Invoice printer.

When the bill is to be paid, the waiter logs in and activates the green
Pay By Table button, the selection will present the tables who have
been billed and are ready to offer payment. Tables that have been
served by the logged in waiter are shown with a red reflection. A
waiter may accept payment for tables not served by them.
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3 Basic Operation

Figure 3.5: Pay by table selection

When the Invoice preview is presented, assuming previews are en-
abled, choosing any option on the Preview other than Close will
process the invoice into the system. The Receipt page will automat-
ically raise in anticipation of payment.
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3.3 Receipt

3.3 Receipt

Figure 3.6: Receipt Page

If enabled you can use the fast cash bank notes to enter an amount
responding to the physical bank notes tendered by the customer. You
can also fill in amounts by hand, if payment is made by Cheque or
Credit Card the exact amount owing will be filled in when the pay-
ment type option is selected. In addition a further field will become
enabled to allow you to enter the cheque or card number.

When a return for refund is processed, the amount tendered field
will contain a negative value indicating the value to be refunded to
the customer. If you would like to leave the amount as a credit in
the account you can simply ignore the Receipt phase, press Ctrl+L
to clear and return to Sales
If the client would like to leave the change as a credit or you receive
a deposit (down payment) then simply check the Keep Credit op-
tion, this will leave the account in credit and set the change due to
0.00 For this to work the selected client must have the Keep Credit
option enabled in their account settings.
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3 Basic Operation

You may also choose to ignore certain invoices when receiving pay-
ment. To do select only the applicable invoices in the selection list
as you do this the amount owning will change to reflect the new
selection. By default all invoices are selected.
When ready you can click the green Process button. After accepting
the presented document the system will clear and again be ready for
sales.
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4 Advanced Operation

4.1 Sales

Depending on the preferences settings it may be possible to alter the
selling price, whether tax is applicable on an item, and to apply dis-
counts. All these features are self explanatory. You can also change
the Department selection, two special cases exist for Notes and Re-
marks, Notes are private and will only appear in audit trails and are
intended for your personal records. Remarks are printed on the In-
voice and intended to inform the customer to related information.

4.1.1 How Item searching works

The Item field is a very versatile tool, you can search for products
by name, part thereof, or item code. When more than one product
matches the description you can drop down a list of matches or scroll
through the list using the arrow keys. When scrolling through the list
the item code indicator will update with each items product code.
When connecting a bar code scanner to your system, you should
program your scanner to append a CR (carriage return) to the end
of the bar code, this will have the effect of automatically adding the
item to your invoice. To add multiple items of the same type, first
enter the quantity then press F2 and finally scan the product. You
can also choose to always verify the quantity by checking the Qty
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4 Advanced Operation

Check option in Misc preferences.
Items can be added to the Invoice by pressing Enter or using the
Ctrl+A accelerator, likewise items can be removed from the invoice
by highlighting the required item then using the Ctrl+R accelerator.
The Add and Remove buttons may also be used.

4.1.2 Order

This will close an invoice temporarily and print any instructions for
items on their designated kitchen printers. It is also possible to di-
rectly use the Print Bill function, that would also print to the kitchen
printers if required but at the same time close the bill in anticipation
of payment.

4.1.3 Print Bill

This closes the invoice for the selected Client / Table / Room and
prints the bill in anticipation of payment.

4.2 Receipt

The receipt process is simple, but we mention a few points that you
may overlook.

1. Always choose the Payment by method first, this will usually
automate the filling in of the rest of the required fields exclud-
ing Cheque or Credit Card no.

2. When payment is made by card it is possible to enter the tip
amount and then have the assistant fill in the total, or to fill in
the amount in which case the assistant will fill in the Tip.
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4.3 Documents

3. When using the fast cash bank note facility, pressing subse-
quent notes add their value to the amount tendered field.

4. Remember you can use Alt+C to get focus to the cash amount
tendered field, and Alt+O to get focus on the coupon amount
field. Clicking the other payment option buttons will fill in
the default payment amount from the selected source. It is
possible to accept payment from multiple sources.

5. When an account is in credit you may simply skip the receipt
process and press Ctrl+L to clear and ready the system for
new transactions.

6. To leave items on account skip the receipt process and press
Ctrl+L to clear and ready the system for new transactions.
The accounts will printed/mailed with the File -> Mail ->
Statements facility, usually done at month end.

7. Bank note setup is done using the Preferences dialogue.

4.3 Documents

The documents page is used to view past documents associated with
an account. You can view Invoices, Receipts, Quotes, and Refunds.
Simply highlight the document you wish to view and click the ap-
propriate colour coded button.

4.4 Client

The client page is used to add customers and/or update their details,
the discount fields will not be editable unless the user has discount-
ing privileges. If the Keep Credit option is checked for a client then
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4 Advanced Operation

they can maintain an account in both credit and debit. This is useful
for customers who pre-pay or who run a tab.

Figure 4.1: Client Page

In addition the Client page may be used to search for customers
using any of the available fields. For example to locate all customers
who have a 5% discount simply enter 5 in the associated discount
field then press Ctrl+F or use the Edit -> Find menu option. You
may also use the wild card % character, for example to locate all
customers who have 5 or 5.x use 5%.
You can use the % wild card in may ways, for example to find all
clients who have phone numbers like xxx 375 xxxx or 375 xxxx or
375x xxx the key would be to locate phone numbers containing 375
so we would use %375%
The wild card character is extremely useful when searching ad-
dresses and notes.
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5 The File menu

Whenever a letter is shown as Underlined a simple key press will
select that menu option.

5.1 Mail

5.1.1 Statements

Using this option will search through the system for accounts with
outstanding balances and compile statements for mailing. Interest
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is calculated on overdue accounts, and long overdue accounts are
printed with a hand over for collection warning. The collection mes-
sage is configured in the SysInfo page?? of the preferences dialogue.

5.1.2 Email

Currently this option is not implemented and should be disabled in
the Personnel preferences.

5.1.3 Renewals

This option is used to create mailings for clients who have products
that require renewals in the near future. An example would be club
membership or licenses.

5.2 Admin

5.2.1 Backup

This will back up your database to a specified file. Unlike your
database server backup tool, the built in TuxDiner backup may be re-
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stored using the dbTuxDiner utility to any of the supported database
architectures.

In addition the Misc preferences dialogue allows you to configure
an application that will write this backup file to media. In the com-
mand the %1 will be replaced with the file name you choose for
your backup.

5.2.2 Cash Up

The Cash Up facility is used to produce Invoice and Payment Sum-
maries, Invoice Histories, Receipt Histories, and Receipt Summaries
for your daily transactions. It can operate in Preview or Print mode.
When operating in Preview mode, the reports are generated and
can be viewed or printed however no housekeeping is done and the
books remain open for further transactions.

When print mode is selected, the reports are automatically printed
for your Accounting records, the books are closed for the day and to-
tals reset. In addition internally transactions are archived, this keeps
TuxDiner running fast and smooth for years and years. You may
only notice delays when retrieving documents or searching for data
that has been archived.

The Cash Up procedure should be run daily, or even at shift changes.

5.2.3 Month End

Month end reports can be generated for any month and year you
require.
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Figure 5.1: Date Selection

The following reports are generated. A Revenue Summary, this lists
the number of clients per day, the total Invoiced, and Received as
well as the average of these per client.

A performance Summary will indicate where your income is being
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generated.
A Tax or Vat Summary will give you a detailed tax report taking
into account discounts, bad debt, arrears etc. In addition it reports
the total and percentages of received payments by payment type.
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5.2.4 Receive Stock

This option will present a dialogue where the operator can enter
details of Stock accepted on delivery.

Figure 5.2: Receive Stock

The operation is simple and works in the same manner as the Sales
page. The Notes field is only added when Process is clicked as these
note refer to the delivery as a whole and not to a specific item. In
most cases the supplier is automatically located. If you have more
than one supplier supplying an item you should select the correct
supplier in the supplier field.
The results of the Receive stock facility can be viewed using the
reports option.

The Notes field is only added when Process is clicked as these note
refer to the delivery as a whole and not to a specific item. In most
cases the supplier is automatically located. If you have more than
one supplier supplying an item you should select the correct supplier
in the supplier field.
The results of the Receive stock facility can be viewed using the
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reports option.

The Item field is a very versatile tool, you can search for products
by name, part thereof, or item code. When more than one product
matches the description you can drop down a list of matches or scroll
through the list using the arrow keys. When scrolling through the list
the item code indicator will update with each items product code.

When connecting a bar code scanner to your system, you should
program your scanner to append a CR (carriage return) to the end
of the bar code, this will have the effect of automatically adding the
item to your invoice. To add multiple items of the same type, first
enter the quantity then press Alt+I and finally scan the product.

Items can be added to the Invoice by pressing Enter or using the
Ctrl+A accelerator, likewise items can be removed from the invoice
by highlighting the required item then using the Ctrl+R accelerator.
The Add and Remove buttons may also be used.

When making stock level adjustments you should check the Stock
Level Adjustment box, this will allow you to enter negative quan-
tities to cater for shrinkage or spoilage.

Depending on the users permissions they may be able to view and
update prices and markups.

5.2.5 Cash Date

This performs the same operation as the Cash Up facility, however
you are presented with a date selection dialogue that allows you to
choose the date for the Cash Up. Note this option can not be used
in place of a cashup operation and is intended to review days in the
past.
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5.2.6 Reset Sequence

Selecting this option will reset the sequence number used on orders
and invoices. It will not affect the invoice number. Usually the
sequence number is reset at the start of each day.

5.2.7 Waiter Cash Up

This option is used to present a report for a waiter cashup at the
end of a shift. The intended use is for establishments who’s waiters
manage and maintain their own cash purse. You start by selecting
the date of the required cashup, next you select the waiter required
from the prompt dialogue, the following reports will be provided.

These reports can also provide some useful information with regards
to your staff performance.

5.3 Logout

Activating the logout option will lock the system and prompt for
a new user code. You should note that this is an application level
control and has nothing to do with the system user login. Each users
preferences and physical layout of the application will be restored
when they log in.
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5.4 Exit

Simply exits the TuxDiner application, this can only be activated
from within a valid session and not while the system waits for a
login.
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6 The Edit menu

Whenever a letter is shown as Underlined a simple key press will
select that menu option.

6.1 Find Ctrl+F

The find facility is used to activate the search engine for customers.
By default the Name field searched when Enter is pressed, all other
fields need activation with this option. The most common use is
to find clients based on account number or any detail in the Client
page. For example to locate all customers who have a 5% discount
simply enter 5 in the associated discount field then press Ctrl+F or
use the Edit -> Find menu option. You may also use the wild card
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% character, for example to locate all customers who have 5 or 5.x
use 5%.
You can use the % wild card in may ways, for example to find all
clients who have phone numbers like xxx 375 xxxx or 375 xxxx or
375x xxx the key would be to locate phone numbers containing 375
so we would use %375%

6.2 Search via Invoice# F12

This option is the preferred method of selecting which Invoice is
to be paid. A dialogue requesting the Invoice number will be pre-
sented, if found the receipt page will be shown with the client/table
preselected and the correct Invoice highlighted ready to accept pay-
ment.

6.3 Change Invoice

This option will allow one to edit an already printed Invoice. This
is useful when the customer notices that the wrong item has been
invoiced, for example an Orange Juice, that should have been part
of their breakfast and not a separate billable item.

6.4 Clients

6.4.1 Merge

This facility allows you to merge two account into a single account.
For example Miss Swan marries Mr Gander, and now they would
like a single account to Mr Gander. Perform the following actions.
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Select Miss Swan in the name field, now use the Merge menu op-
tion, next select Mr Swan in the name field and again use the Merge
menu option. Miss Swan’s account will now be taken over by Mr
Ganders account. Of course dialogues guiding you and confirming
your actions will be presented as you proceed.

6.4.2 Purge

When you choose to purge a client from your system, all records
relating to that client will be removed. Before the actual purge takes
place you will be offered the chance to print out records of the client
to keep on file.

6.5 Manage
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6.5.1 Departments

Figure 6.1: Departments

You may add as many departments as are required, however it may
be prudent to think about operation of the touch interface and the
number of levels that may be required to navigate. The order of the

58



6.5 Manage

Departments on the touch panel can be adjusted using the Up and
Down rank buttons. The touch display is populated from left to right
and top to bottom.
Departments also have a definition as to which kitchen printer is
used (if any) , simply check the required option.

6.5.2 Inventory

Figure 6.2: Inventory

When inserting new entries the code must be unique, product bar
codes can be used with TuxDiner, or you may choose a simple as-
cending number. If left blank TuxDiner will try choose the next
sequential number automatically. The unit of measure is used in the
invoice and the audit history.
The Cost, Markup, Sell exc. and Sell inc. fields all work together,
in addition if Tax’s are enabled the Tax check buttons affect the Sell
inc. Fields. When the tax, cost or markup of an item is changed
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the two sell fields will automatically update to reflect the new sales
price. In practice it often occurs that the final selling price becomes
something like R146.01 this causes change problems for typical
cash items such as bags of dog food. In this case you might elect to
adjust the selling price by hand to R146.00 bear in mind that coupled
with your tax rate it may not be possible to get a rounded number.
For example with a TAX rate of 14% and a selling price or R148.24
the total inclusive would be R168.99, changing the selling price to
R148.25 would result in a selling price of R169.01
You adjust the price by modifying the Sell exc. Field, as you modify
this field, the Sell inc. price will update. You will also notice that
the Sell exc. field changes colour to red, this is to warn you that the
price has been modified, and is not the same as the automatically
calculated price.
It is also possible to adjust the final selling price including VAT.
When adjusting this field the ENTER key must be pressed to force
an update of the Sell exe. field.
When deleting, updating, or creating new entries dialogues will con-
firm your requested action, and warn you when data will be changed.
Errors are also reported via dialogues, get into the habit of read-
ing the messages in these dialogues as they are there to prevent un-
wanted actions from destroying your data.
The supplier field its possible entries from the list of suppliers that
is managed in the Supplier panel. The use of this field is critical if
you wish to use the automatic stock control and ordering facilities
of TuxDiner.
To disable stock control on any items adjust to ToQuantity to 0, this
will inform the system that no stock control on this item is required.
For services such as annual licenses that should be re-purchased it is
possible to set the DTR (Days to Renewal) field to contain the num-
ber of days till the repurchase is required. For example an annual
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license would be set to 365. Using the File, Mail, Renewal menu
option the system will automatically produce a Renewal Reminder
within 20 days of the renewal expiry date. These reminders are used
to preempt your clients to purchase a renewal of the item or service.

The order of the Inventory items on the touch panel can be adjusted
using the Up and Down rank buttons. The touch display is populated
from left to right and top to bottom.

By using the Department filter you can choose to display only in-
ventory items that exist in the selected department. This is useful
when you have a large number of stock items.

6.5.3 Orders

Activating this option will check all Merchandise stock levels and
generate order forms for suppliers who’s product ranges are below
the re-order level. The system will not re-order items already on
back-order.

When the document is presented for printing the behavior is iden-
tical to that of Invoices and Receipts in that the Close option will
cancel the request, all other options will result in the system assum-
ing the transaction is completed.

6.5.4 Suppliers

The supplier page provides simple record management of the sup-
pliers of Merchandise to your business. The Company field is used
in Merchandise management to ensure that automatic order forms
can be created.
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Figure 6.3: Suppliers

All the fields are self explanatory, but beware unlike other fields
there is no automatic formatting so care should be used to enter data
in a manner that will produce acceptable printouts. For example we
suggest using "Hills" vs. "hills”
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6.6 Clear All Ctrl+L

The Clear all facility clears the interface and places the system in
a state read to start new transactions. All references to previously
access accounts are cleared. This is mostly used after invoicing to an
account that has a credit option and will pay later, when the Receipt
page is raised, Ctrl+L will ready the system for the next customer.

6.6.1 Preferences

This will activate the Preferences dialogue, see section 2
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Whenever a letter is shown as Underlined a simple key press will
select that menu option.

7.1 Statement

Activating this facility will display a statement for the currently se-
lected client. This will be done even if that clients balance is 0 or
in debit. This is an extremely fast and simple technique to confirm
inquiries from clients as to their account status.

7.2 Journal

Activating this facility will display a journal trail of Invoices and
Receipts for the currently selected client. The trail can be printed or
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emailed if required.

7.3 Audit

Activating the Audit trail will present a document containing a com-
plete and detailed trail of all transactions made with the currently se-
lected client. In addition your private notes will also be displayed in
this trail. The audit trail is your tool for sorting out possible conflicts
with clients over purchases and payments.

Your private notes could be useful in reminding you of promises you
or your staff might have made that now only your client remembers.
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7.4 Reports

The reporting functions of TuxDiner assist you in your ERM and
CRM of your company. If you require additional reports and func-
tionality you should lodge a feature request with us at info@tuxsoft.co.za

Reports fall into to main categories, historical reports and current
reports. Historical reports provide you with comparisons over a six
month period. When presented with the date selection for historical
reports the date selected is month 6 of the six month period. For
current reports it is the month for that report.
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Figure 7.1: Date selection

In addition historical reports can have items selected to chart for a
visual comparison of these results.
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Figure 7.2: Charting Reports
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To Chart Items simple select and highlight the entries required then
click the Chart Button.

7.4.1 Outstanding Invoices

This report presents a fast table of outstanding Invoices, useful to
tell if a table being vacated has paid their bill.

7.4.2 Pending Orders

This report produces a table of clients / tables who have placed or-
ders but have not yet received their bill, it can be useful to check if a
table is waiting to be served or waiting to receive their order or bill.

7.4.3 Inventory Performance

The merchandise report will generate a historical comparison of
merchandise sold over a six month period until the date selected.
The merchandise report supports charting of your results. Click-
ing on the column titles will sort the list of items according to that
column. A second click reverses the sort order.
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Figure 7.3: Inventory Performance

7.4.4 New Clients

The new clients report will generate a historical comparison of the
number of new client your business has registered over a six month
period until the date selected. The new clients report supports chart-
ing of your results. Clicking on the column titles will sort the list
of items according to that column. A second click reverses the sort
order.

7.4.5 Client Purchases

The client purchases report is a current report that gives the items
purchased per client for the selected month. This may be useful in
deciding which clients should be sent information on a promotion
you may be having.
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hat gives the items purchased per client for the selected month. This
may be useful in deciding which clients should be sent information
on a promotion you may be having.

Figure 7.4: Client Purchases

Use the column heading to sort by Client, Description or Quantity.

7.4.6 Client Expenditure

The client expenditure report is that gives the total expenditure per
client for the selected month. This may be useful in determining dis-
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count offering for clients based on expenditure rather than frequency
of visits.

Figure 7.5: Client Expenditure

7.4.7 Client Debt

A report that is useful for the terrible task of collection of moneys
outstanding. All clients with outstanding debt are shown. Those
who are overdue are shown in red. In addition the contact details for
the clients are shown.

With business’s that have a common client base this list can be used
as a shared list of clients who have bad debt.
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7.4.8 Commissions

Figure 7.6: Commissions

The commissions report presents a table of commission due to your
sales personnel. Entries shown in Red are on sales made but not yet
paid for.
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7.4.9 Stock Levels

Figure 7.7: Stock Levels

The stock levels report presents a list of stock, the quantity on hand,
the quantity on order, and an empty slot to fill in hand count for
reconciliation.

7.4.10 Received Stock Audit

This report is unique in that it presents documents for printing or
viewing. Whats more it may present multiple documents in succes-
sion. In fact one document for each delivery that took place during
the selected month.
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Figure 7.8: Received Stock Audit

Notes for the delivery are shown in mauve, subsequent suppliers are
grouped and highlighted fore easy identification.
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7.4.11 Actions

The actions report is a log of all activity that has taken place ex-
cluding normal sales and invoicing operations, discounts and price
changes are logged. The actions log is intended to help you keep
tabs on your staff and locate any abnormal behavior. It can clearly
indicate when staff are having problems with various aspects of your
business or the use of TuxDiner. After viewing the log you may op-
tionally clear it.

7.4.12 Sales Person Performance

Provides a table containing the sales performance for the past six
months from the date selected.

7.4.13 Performance Analysis

Provides a selection of reports in the same fashion as a month end,
however you can select the start and ending date ranges for the re-
port. It includes a Revenue Summary, Performance Summary, and
am Income Summary.

7.4.14 Price List

Provides a table containing sales prices grouped by department.

7.4.15 All Clients

Provides a table of Clients / Tables /Rooms present in the system.
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7.4.16 Returnables

Provides a table of outstanding returns, typically this is used to keep
track of items such as cutlery and crockery that may have been on
loan to clients who have take out orders.

7.4.17 Daily Stock Sales

This report provides a table containing the item code, item descrip-
tion, cost and sales price of all items sold on a given day, it can be
exported to be used in a spread sheet if required.

7.4.18 Voided documents

This report provides a list of voided documents within a given date
range.

78



8 The Help menu

8.1 Contents ...

This presents an online version of this users guide.
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8.2 About

Figure 8.1: Help About

The help about dialogue presents information on the logged in user,
their default cash account, and your license or lease status.
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9 System Customisation

In this chapter we describe how you can customise various aspects
of TuxDiner to suit your environment.

9.1 Creating a new language

You can select the language that each user will have the TuxDiner
GUI operate in from the Personnel page in the Preference dialogue.
Before a language can be chosen its message catalogue must be cre-
ated. This process is not complex, but is rather time consuming.
To create a new message catalogue or update an existing catalogue
follow these steps.

1. Change directory to /opt/tuxsoft/i18n/TuxDiner (Windows use
C:\Program Files\TuxSoft\i18n)

2. Check if a message catalogue for your locale exists, if so pro-
ceed to step 4

3. Copy each of the template file to the required name matching
your locale. For example ..
cp i18n.ts af_ZA.ts

4. Run the application ‘linguist’ and open the newly created ’ts’
or existing catalogue file.

5. Add translations for all needed texts, Save and then Release
your translations.
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6. Change directory to /opt/tuxsoft/share/TuxDiner
7. Copy the English directory to one with the name of your newly

created language. For example..
cp -a English af_ZA
or...
xcopy /E English af_ZA

8. Edit each of the document parts in your new folder translating
all strings as required.

9. Start TuxDiner and select the new language in the SysInfo
page of the Preferences dialog.

9.2 Customising your Documents

TuxDiner uses a versatile system for document printing. All docu-
ments are created from a simple subset of HTML templates. Note
do not use Java or Java Script they are unsupported. These template
are divided into three sections. WARNING DO NOT USE WYSI-
WYG HTML TOOLS, USE ONLY A PLAIN TEXT EDITOR,
USING MICROSOFT TOOLS FOR WEB EDITING OR EX-
TENSIONS WILL BREAK YOUR SYSTEM.

1. The Head - this contains the title, the client and your address
information, and the basic header for items to be added to the
document.

2. The Items - this contains a repeatable section that is used to
add items to the document.

3. The tail - this closes the document off and adds any footers
required.

Data is replaced into the documents by searching them for $key-
words embedded in standard HTML comments. For example <!–
$date–> might be replaced with 2004-09-04
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The existing documents are contained in share/TuxDiner/English
folder of where TuxDiner is installed, on Linux the default is /opt/tuxsoft
and on windows c:\Program Files\Tuxsoft or c:\Program Files(x86)\TuxSoft
You can examine these an gain a clear idea of the principles used.
You can also commission us at Tuxsoft to customise your documents
to suite your requirements. If you have created a new language or
are using one of the onse supplied, replace English with the lan-
guage created, Eg. af_ZA

In addition some templates are stored in TAX1 and the TAX2 fold-
ers, these are choosen depending on the tax selections made in Pref-
erences. The structure uses a fallback system falling back from
TAX2 to TAX1 and finally back to the template root, Eg. English.

The following Documents are available, all have the format of DocHead.html
DocItem.html and DocTail.html we do not recommend editing the
Audit, Journal, Stock, Cashup or Monthend classes.

9.2.1 Invoice

The Invoice has the following keywords, remember to embed with
<!–$keyword–>
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Table 9.1: Invoice Head Keywords
Keyword Description

logo Image source for fancy logo
number Document number

date localised date
datetime localised date and time
shortdate yyyy-mm-dd

time hh:mm:ss
acc Clients account number

client Clients name
postal Clients postal address

shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.

email Clients email address
aline1 Address line 1 as in SysInfo
aline2 Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 Address line 6 as in SysInfo
aline7 Address line 7 as in SysInfo

sequence sequence number of the day (Order number)
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Figure 9.1: Invoice Item Keywords
Keyword Description
quantity The number of items
iquantity Integer number of items.

uom Unit of Measure
department The department of the item
description The description of the item

date localised date
datetime localised date and time
shortdate yyyy-mm-dd

time hh:mm:ss
price the price of the items(s)

unitprice The unit price of the item.
category The category of the item
discount The discount given

tax1 Y or N to indicate taxable
tax2 Y or N to indicate taxable

taxflags * = Tax1, # = Tax2, exempt
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Table 9.2: Invoice Tail Keywords
Keyword Description

tax1 Value in % of tax1
tax1name Name of tax Eg. VAT
tax1total Value of tax1

tax2 Value in % of tax2
tax2name Name of tax Eg. GST
tax2total Value of tax2
subtotal Total excluding taxes in Exclusive mode

total Total including taxes
exctotal Total of tax exempt items

exc1total Total of tax1 exempt items
exc2total Total of tax2 exempt items
invfoot1 Invoice Footer as in SysInfo
invfoot2 Invoice Footer as in SysInfo
cashier Name of the personal logged in.

date localised Date of transaction
datetime Localised date and time of the transaction
shortdate yyyy-mm-dd

time hh:mm:ss
sequence Order number
number Invoice number

acc Account Number
client Client name

9.2.2 Quote

The Quote has the following keywords, remember to embed with
<!–$keyword–>
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Table 9.3: Quote Head Keywords
Keyword Description

logo Image source for fancy logo
number Document number

date localised date
datetime localised date and time
shortdate yyyy-mm-dd

acc Clients account number
client Clients name
postal Clients postal address

shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.

email Clients email address
aline1 Address line 1 as in SysInfo
aline2 Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 Address line 6 as in SysInfo
aline7 Address line 7 as in SysInfo
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Figure 9.2: Quote Item Keywords
Keyword Description
quantity The number of items
iquantity Integer number of items.

description The description of the item
price the price of the items(s)

unitprice The unit price of the item.
category The category of the item
discount The discount given

tax1 Y or N to indicate taxable
tax2 Y or N to indicate taxable

taxflags * = Tax1, # = Tax2, exempt
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Table 9.4: Quote Tail Keywords
Keyword Description

tax1 Value in % of tax1
tax1name Name of tax Eg. VAT
tax1total Value of tax1

tax2 Value in % of tax2
tax2name Name of tax Eg. GST
tax2total Value of tax2
subtotal Total excluding taxes in Exclusive mode

total Total including taxes
exctotal Total of tax exempt items
exc1total Total of tax1 exempt items
exc2total Total of tax2 exempt items
invfoot1 Invoice Footer as in SysInfo
invfoot2 Invoice Footer as in SysInfo
cashier Name of the personal logged in.

date Date of transaction

9.2.3 Receipt

The Receipt has the following keywords, remember to embed with
<!–$keyword–>
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Table 9.5: Receipt Head Keywords
Keyword Description

logo Image source for fancy logo
number Document number

date yyyy-mm-dd
acc Clients account number

client Clients name
postal Clients postal address

shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.

email Clients email address
aline1 Address line 1 as in SysInfo
aline2 Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 Address line 6 as in SysInfo
aline7 Address line 7 as in SysInfo

Figure 9.3: Receipt Item Keywords
Keyword Description

description The description of the item
payment The amount paid
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Table 9.6: Receipt Tail Keywords
Keyword Description

tender Total amount tendered
change Change due

outstanding Outstanding amount on account
recfoot Receipt footer as in SysInfo

9.2.4 Statement

The Statement has the following keywords, remember to embed
with <!–$keyword–>
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Table 9.7: Statement Head Keywords
Keyword Description

logo Image source for fancy logo
number Document number

date yyyy-mm-dd
acc Clients account number

client Clients name
postal Clients postal address

shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.

email Clients email address
aline1 Address line 1 as in SysInfo
aline2 Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 Address line 6 as in SysInfo
aline7 Address line 7 as in SysInfo

Figure 9.4: Statement Item Keywords
Keyword Description

date yyyy-mm-dd
description The description of the item

amount The value of the transaction
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Table 9.8: Statement Tail Keywords
Keyword Description

total Total for the statement
current Current balance
day120 120+ Day balance
day90 90 Day balance
day60 60 Day balance
day30 30 Day balance

statefoot1 Statement footer as in SysInfo
statefoot2 Statement footer as in SysInfo
statefoot3 Statement footer as in SysInfo

handed Message if account handed for collection, blank if not.

9.2.5 Slip and ASCII printers

There are a few very basic features that may be used when creating
forms for your slip or ASCII printer. In the preferences editor you
can define codes for BOLD on, BOLD off, Emphasised on and Em-
phasised off text modes, the template files have the extension .slip
and .slip40
Here are some examples for an HP laser or deskjet.

Table 9.9: HP slip codes
BOLD ON 27,40,115,49,66
BOLD OFF 27,40,115,48,66

EMPHASIZED ON 27,40,115,49,83
EMPHASIZED OFF 27,40,115,48,83

An example of an Epson FX series printer
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Table 9.10: Epson FX slip codes
BOLD ON 27,71
BOLD OFF 27,72

EMPHASIZED ON 27,69
EMPHASIZED OFF 27,70

An example for Epson ESC/POS slip printers

Table 9.11: Epson ESC/POS slip codes
BOLD ON 27,71,33
BOLD OFF 27,72,32

EMPHASIZED ON 27,69,33
EMPHASIZED OFF 27,70,32

Text justification

It is also possible to justify parameters to some extent in the slip
templates, to left justify to a given with use the following format.
[-38]<!--$owner--> to right justify use the following format
[38]<!--$aline1-->

So for example you template might include the line..
[-38]<!--$owner-->[38]<!--$aline1-->

This would place the owners name on the left of the page and the
name of your practice on the right.

Embedding Codes

You can also embed printer specific codes into your documents us-
ing the &code& facility. A common use would be in the tails of
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9.2 Customising your Documents

documents where one would like the printer to form feed the page.
In this case we would simply use the code &12& at the end of out
template.
You could also use this technique to set your page length, cut the pa-
per, or even print the document type in a larger font. The embedded
codes however have no effect on the preview dialogue.

Comments

Slip templates now support comments using the standard # as a com-
ment indicator. The # must be the first character in a line for that line
to be treated as a comment.
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License

This document and associated software are copyright © 2007 though
2013 TuxSoft CC. All rights reserved.

Granted Rights

You may install and distribute this software freely provided that the
complete package is distributed and all credits to TuxSoft remain.
You may not distibute your License Key

Limitations of Liability

In no event shall the developers or copyright holders be liable for
any damages whatsoever, including - but not restricted to lost rev-
enue or profits or other direct, indirect, special, incidental or conse-
quential damages, even if they have been advised of the possibility
of such damages, except to the extent invariable law, if any, provides
otherwise. Warranty The Software and associated documentation
are provided AS IS with NO WARRANTY OF ANY KIND, IN-
CLUDING THE WARRANTY OF DESIGN, MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE.
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